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A B O U T  E M A I L  C O M M U N I C A T I O N S  &  T H I S  G U I D E
Mastering the art of drafting sharp, clear emails and keeping your inbox in check is like being the conductor of a symphony—when done right, everything flows in 
harmony! 

A well-written email is your digital handshake, your elevator pitch, and your problem-solver all rolled into one, while a tidy inbox is your mission control, keeping chaos 
at bay.  Let messages pile up, and suddenly you're Indiana Jones dodging a boulder of unread notifications.  But get it right, and you become a communication ninja—
swift, smart, and respected.  After all, in the fast-paced world of work, those who write well and reply on time don’t just survive—they thrive.

This learning guide offers helpful tips for drafting and proofreading email communications and it suggests ways to manage your inbox and tame the flow of 
information.   

“Email is like laundry – it piles up faster than you can keep up with it.” - Anonymous

“Email is both a curse and a blessing.  It’s fast, cheap, and easy – which is exactly why it’s so 
dangerous.” - Anonymous

“Inbox Zero isn’t a destination.  It’s a philosophy.” – Merlin Mann, the original champion of Inbox Zero 

“You are what you forward.” – Erica Jong
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D R A F T I N G
• When drafting an email message, begin with the end in mind. Start by 

asking, “Is an email appropriate?”  If your communication contains sensitive 
information, if the message could be emotionally charged (in the eyes of the 
recipient) or if the message contains complex concepts or detailed content, 
email may not be the best form of communication.  

• Recognize who needs to see the message.  And, more importantly, who 
doesn’t.  Limit the recipients to only those who need to know.  Sometimes, 
less is more.  Use the “To” field for anyone who needs to take action or who 
is the primary audience.  Use the “cc” field for anyone else who needs to 
know.

• Ensure the subject line is appropriate.  It should be specific and concise.  
Use words that support finding the message later, using a key word search.

• Be polite and professional.  Start with an appropriate greeting such as Dear 
[Name], Hello [Name], Hi [Name], [Name], Greetings, Good morning! or 
Good afternoon!

• Monitor for message clarity and readability.   Be concise, focused, use short 
paragraphs and leverage bullet points when appropriate.   

“Your emails are ALWAYS clear 
to you—or you wouldn’t have 
written them as you did. Clear in 
the mind of the reader is what 
counts.”

—Dianna Booher, from Faster, 
Fewer, Better Emails
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• Call out any due dates or action required by underlining or bolding text, 
using a different color font or by highlighting key information.  Due dates or 
a call to action should not be a needle in a haystack.  The information should 
be prominent.

• Be respectful and polite.  Monitor for any unintended tone.  Be neutral.  

• Say enough but not too much.  Balance is key! 

• If your message references website links or attachments, ensure the links are 
functional and the attachments are included.  If sending an attachment, 
monitor for size.  Some company email servers will not accept messages with 
attachments larger than 10 MB.  Many companies allow messages with 
attachments that are up to 20 MB.  

• Include a professional closure to your message.  Consider options such as 
Thanks, Thank you, Best, Best regards or Sincerely.  

• When sending messages outside of your organization, use your signature 
block.  

• Emojis are unnecessary in business communications.  They should be used 
sparingly. 

“As with subject lines, keep your 
signature block informative, 
useful, and brief.”

—Dianna Booher, from Faster, 
Fewer, Better Emails

"There is no great writing, only 
great rewriting.“

—Justice Brandeis
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S T E P  2 :  
P R O O F R E A D I N G
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• Again, monitor for tone and ensure your message is clear and articulate. 

• Use the “Spelling and Grammar” tool (for basic spelling and grammar checks) 
or the “Editor” tool (for more advanced suggestions regarding writing style, 
clarity and other refinements) of Outlook to help identify edits. 

• Verify the correct recipients appear in your “To” and “cc” fields. 

• Ensure any attachments are included and any links are functional. 

• If your message will be sent to a large audience or to executives, consider 
using the “Read Aloud” feature from the Review menu.  It is amazing how 
many edits the function can detect – items that spell check may not catch.

“There’s a life and death in every 
email.”

—Bill Gates

“Be bold.  Be fast.  Get to the 
point right away.  The best email 
communication is simple and 
clear.

—Constance Hale

Compliance & Ethics Forum for Life Insurers        |  

S O F T  S K I L L S  S E R I E S  A N A T O M Y  O F  A N  E M A I L  L E A R N I N G  G U I D E

ANATOMY OF AN EMAIL

CEFLI Soft Skills – Anatomy of an Email

P R O O F R E A D I N G



8

• Before sending your message, select the folder where the message should 
be saved if something other than the “sent mail” folder is desired.  Within 
the Options menu, click on the “Save Sent Item To” option then navigate to 
the appropriate folder where your outgoing message will be retained. 

• If you would like your message sent later, use the “Delay Delivery” feature 
within the Options menu.  However, use caution.  Delayed messages will 
not be sent unless you are logged on when the message is scheduled to 
be delivered.  Otherwise, the messages will not be sent until the next time 
you log on. 

“To write is human, to edit is 
divine.”

—Stephen King

Proofreading

(v.) We do it best after we’ve hit 
“send.” 
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• Experiment with an Inbox Zero approach.  The concept, developed in 2006 
by Merlin Mann, aims to keep your inbox empty or almost empty.  

• Avoid reviewing messages in your inbox multiple times.  Review once and 
make a decision:  File, delete, delegate it, take immediate action or add an 
item to your to do list.  Effectively triage incoming messages then implement 
timely follow up with next steps.  Email management is a discipline. 

• Consider using folders to help organize messages that need to be retained.  
To create a folder, right click on the “Inbox” label in the left navigation area 
of your Outlook window and select “New Folder.”  Or, from the menu at the 
top of your Outlook window, select “Folder” then “New Folder.”   Tip:  If you 
include the year in your folder name (e.g., “Annual Conference – 2025”) it is 
easier to identify folders to be archived at the end of each year.  Your inbox is 
not for archiving emails, folders are.  Your inbox is for messages in need of 
review and triaging. 

• Establish a system for email management that works for you.  While the 
approaches are endless, consider reviewing emails at certain times of the 
day and consider devoting the last half hour of your day to email 
management.  Quicky make decisions on every item in your inbox.  Delete 
messages that are not needed. File messages that do not require additional 
action but should be retained for future reference.  Delegate, or add to your 
to do list, messages that require action.

“For every minute spent 
organizing, an hour is earned.”

—Merlin Mann, pioneer of the 
“Inbox Zero” concept

“Clutter is nothing more than 
postponed decisions.” 

—Anonymous
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• Consider creating a “Travel” folder to add travel confirmations, itineraries 
and receipts.  It’s helpful to have everything in one place when you are away 
from the office.  Such organization can also streamline your expense 
reporting later. 

• Consider creating a “Temporary Items” folder that can be used to file 
messages that should be saved in the short term (i.e., up to 90 days).  
Contents in the folder are low hanging fruit when it’s time to clean up older 
messages and reduce the size of your email file. 

• If you are not able to respond to an email within 24 hours, acknowledge 
receipt of the message and indicate when you plan to respond.  This simple 
action is not only professional (and takes little time), it pays dividends since it 
avoids the need to process additional follow ups or reminder messages 
from the sender.  

• Unsubscribe from senders who offer content that does not provide value to 
you.  The small investment in time pays dividends later. 

• If you desire less email, limit the number of recipients included in the cc and 
bcc fields of messages you send.  

• When responding to a message, read thoroughly and answer all the 
questions to avoid more email in the form of future follow-up messages. 

“Email is a system that delivers 
other people’s priorities to your 
attention.”

—Chris Brogan

“The more you check your email, 
the less you actually accomplish.” 

—David Allen
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• Consider color coding messages from select senders.  From the “View” tab, select “View Setting,” then “Conditional Formatting.”  Select “Add.”  Name the rule (for 
example, the rule name could be the sender’s name) and select “OK.”  Set the condition and select the font, style, size and color before selecting “OK.”   
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• Flagging messages for additional review may be an effective tool when managing your 
inbox.  From your list of email messages in Outlook, right click on a message you would like 
flagged.  Select “Follow Up” then select the option you prefer.  The “No Date” option works 
well.  Selecting that option will add a visual red flag to the message in your inbox list and it 
will add a light-yellow background to the email in your list of messages.   

• Alternatively, if you select “Custom,” you can set a 
date and time to receive a reminder alert/pop-up.  
Doing so will result in a visual alert (akin to a 
meeting reminder notice) on the date and time you 
specified. 
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• If you will be away from the office for a day or more, use an out-of-office 
message to alert senders of your status.  When others are aware you are 
away, they may be less inclined to send follow-up messages.  They may even 
seek help from other individuals within your organization, in your absence. 

• To set up an out-of-office message, select “File” then “Automatic Replies.” 
Choose the date range when your out-of-office message should be sent and 
draft the text of your message.  Keep in mind there are two tabs– one for 
messages received from within your organization and one for messages 
received from individuals outside of your organization.  You may want to use 
the same or different messages for each audience.  

• When crafting your out-of-office message, it’s often helpful to indicate when 
you will return.  

• If you have someone supporting you while you are away, you may want to 
reference their contact information in your out-of-office message. 

A Few Out-of-Office Options

“Thank you for your message.  I’m 
currently out of the office with 
limited access to email.  I will 
respond as soon as possible after 
[insert date].” 

“I’m currently OOO and will return 
on [date].”
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A Quick Read

• If you are looking 
for helpful tips on 
crafting effective 
messages, consider 
reading the book 
Smart Brevity.  It’s a 
fast read that offers 
a specific format for 
promoting efficient 
and effective 
communications. 
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The Smart Brevity Approach: 

[Greeting], 

[Strong lede – one sentence.]

WHY IT MATTERS: 

[Add short, succinct content.] 

THE DETAILS

[Be crisp and articulate; use 
links and bullet points.]

[Signature]
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T H E  F O R U M  T H A T  C O N N E C T S .
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